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Chapter 1

Introduction to the New Author Guide1

1.1 The Purpose of this User Guide

The purpose of this user guide is to instruct new Connexions authors on creating, revising, and publishing
content with the Connexions system.

1.2 Who Should Use this Guide

This user guide is intended for anyone who wants to author material in Connexions.

1.3 What this Guide Contains

The topics addressed in this guide are:

• Connexions Accounts - An account enables you to write, edit, and publish your content in Connex-
ions.

• Workgroups - A workgroup is similar to a �le directory on your computer. A directory in which you
create and edit your documents before you publish them.

• Importing Microsoft Word Documents - Connexions can do what it does because its content is
marked up with XML-based tags called CNXML. But do not worry, you can import Word documents
directly into Connexions and sidestep the CNXML.

• Revising Your Content - You can edit your content in Connexions by re-importing your Word
document or by using an editor provided by Connexions.

• Publishing in Connexions - When you are ready for the world to see your content, you publish it.
Anyone anywhere with an Internet browser and access to the Internet can view your content after you
publish in Connexions.

• Additional Connexions Information Sources - Additional bits of information about Connexions
that you may want to learn and use.

1.4 A Brief Description of Connexions

Connexions is a Web-based document creation and management system for education and research materials.
There are two parts to Connexions: a Content Commons that contains these materials and the software tools

1This content is available online at <http://cnx.org/content/m14346/1.2/>.
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2 CHAPTER 1. INTRODUCTION TO THE NEW AUTHOR GUIDE

necessary to create, manage, and access these materials. A tour of the workings of Connexions and its parts
appears on the Connexions Web page (http://cnx.rice.edu)2 , under the "About" tab.

From its inception, Connexions was designed to allow the collaborative development and free availability
of material. Instructors and authors can use and reuse the material in Connexions for any educational
purpose. Connexions o�ers Free/Open Source software tools to help instructors and authors manage these
information assets for sharing and advancing knowledge to bene�t of students in the global educational
community. All of this is accomplished through the use of the Creative Commons Attribution license3

(http://creativecommons.org/licenses/by/2.0/).

2http://cnx.rice.edu
3http://creativecommons.org/licenses/by/2.0/



Chapter 2

Getting a Connexions Account1

note: This module has been retired as it contained Connexions documentation which is no longer
accurate and/or relevant. The current documentation of topics in this module can be located
at http://cnx.org/content/m10884/latest/2. Please visit the help page3 for up-to-date informa-
tion about the Connexions website, including support for viewing and authoring content and the
CNXML language. If you have any additional questions or cannot �nd the answer to your question,
please contact techsupport@cnx.org4 and we will be happy to assist in any way we can.

1This content is available online at <http://cnx.org/content/m13050/1.3/>.
2"Introduction to Connexions": Section Account Requests <http://cnx.org/content/m10884/latest/#createaccoutsection>
3http://cnx.org/help
4techsupport@cnx.org
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Chapter 3

Setting Up a Workgroup1

note: This module has been retired as it contained Connexions documentation which is no longer
accurate and/or relevant. The current documentation of topics in this module can be located
at http://cnx.org/content/m10885/latest/2. Please visit the help page3 for up-to-date informa-
tion about the Connexions website, including support for viewing and authoring content and the
CNXML language. If you have any additional questions or cannot �nd the answer to your question,
please contact techsupport@cnx.org4 and we will be happy to assist in any way we can.

1This content is available online at <http://cnx.org/content/m13049/1.5/>.
2"MyCNX and the Work Areas": Section Creating a New Workgroup

<http://cnx.org/content/m10885/latest/#createworkgroupsect>
3http://cnx.org/help
4techsupport@cnx.org
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Chapter 4

Importing Microsoft Word Documents1

4.1 Overview

You can convert an existing Microsoft Word document into a CNXML �le, which is the �le in a Connexions
module that contains the text and instructions for displaying images or other �les. To convert a Word
document you must �rst create a new module and then import the Word document into the module. The
Import function applies CNXML tags to the Word paragraph and character styles.

note: The Word �le converts more smoothly and needs less �ne tuning of the CNXML if you
apply the styles in the Connexions document template to the Word �le before you import it. Use
of the Connexions document template is optional, but we recommend it.

Connexions documents contain not only structural information about the document, but also semantic
information. This means that you do not simply highlight some text and designate it as bold. Rather,
you highlight the text and designate it as a "term" or as a "quote". When your document is uploaded to
Connexions, the structure and the semantics are both preserved. Using Connexions styles is easy. If you
have used styles in Microsoft Word before you will not have a problem. If you have not, have no fear, you
will be using styles in no time.

4.2 The Connexions Template

Before you start creating Connexions modules from Word documents, we recommend that you obtain a copy
of the Connexions document template.

4.2.1 Obtaining the Connexions Document Template

To download the template from the Connexions Web site and to install it on your computer, use the following
steps:

1. Click the following link to download a copy of the template: Connexions document template2 . A
dialog box opens, displaying options for opening or saving the template �le.

2. Specify that the template �le should be saved to the desktop on your computer and click OK.
3. Launch Microsoft Word on your computer.
4. Reduce your window size so that the document template icon is visible on your desktop.
5. From the Word File menu, click New.
6. Drag and drop the document template icon into the "General" tab of the "New" document box.

1This content is available online at <http://cnx.org/content/m13056/1.3/>.
2http://cnx.rice.edu/help/Connexions-Document.dot
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8 CHAPTER 4. IMPORTING MICROSOFT WORD DOCUMENTS

Figure 4.1: The "General" tab on Microsoft Word's "New" document dialog box.

Now you can apply the Connexions document template to your Word documents.

4.2.2 Creating a New Word Document with the Connexions Template

To create a new Word document that uses the Connexions document template, use the following steps:

1. Launch Microsoft Word on your computer.
2. Select New from the "File" drop-down menu. An empty document will open and the "New" document

dialog box displays.
3. Select the Connexions-Document.dot icon from the "General" tab on the Microsoft "New" document

dialog box.
4. Click OK.
5. Enter your content into the new document.
6. Apply the appropriate paragraph and character styles to the content as you enter it.

4.2.3 Applying Connexions Styles to an Existing Word Document

To apply the Connexions styles to an existing Word document, use the following steps:

1. Complete the process to obtain the Connexions document template.
2. Launch Microsoft Word and open your existing document.
3. Select "Format" from the menu bar.
4. Select "Theme" from the drop-down menu.
5. Click the "Style Gallery" button.
6. Select Connexions-Document.doc from the "Template" box. The styles from the template are copied

into your document. If the Connexions style names match the style names in your existing document,
then the Connexions styles are automatically applied to those items.

7. If the style names do not match, you must apply the Connexions template styles to the appropriate
items in the existing �le. To apply a paragraph style, place the cursor in the paragraph and select the
style from the Style drop-down box in the Word Formatting toolbar.
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note: Paragraph styles display the paragraph symbol next to their name in the drop-down
box.

To apply a character style, highlight the word or words and select the style from the Style drop-down
box in the Word Formatting toolbar.

note: Character styles display an "a" next to their name in the drop-down box.

8. Repeat the previous step for all the content in the �le.

Please note these instructions are for Word 2000. The process for other versions of Word will be similar.
Consult your Word Help feature if you have questions with a di�erent version of Word.

4.3 Importing Your Word Document

When your Word document is complete, you are ready to import it into Connexions. To import the Word
document, use the following steps:

1. Log into Connexions.
2. Display the Connexions workspace or workgroup in which you want to work on your document.
3. Create a new module in which you will import your Word document. See Creating New Items in a

Workgroup for instructions on creating a new module.
4. Click the "Edit" tab in the new module, if it is not already displaying.
5. Select Microsoft Word from the Import drop-down list and click Import.
6. Click Browse and locate your document.
7. Click Import to upload your document. Your new document is uploaded and ready to edit or publish

in Connexions.

Figure 4.2: The "Edit" tab showing the "Import/Export module" box.
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warning: Importing a Word �le into an existing module will overwrite the contents of the existing
module with the contents of the Word �le. Be careful not to import a Word �le into a module that
contains content you want to save.

Feel free to edit your module using our editor, or make your changes in the Word �le and repeat the import
process.

Word documents can be extremely varied. We have attempted to handle many common cases, with the
goal of extracting the text from your document so that you can mark it up in CNXML without having to
retype the content. Some cautions:

• Formatting (such as bold and italics) is not preserved.
• Some images and other objects may import correctly and become �gures in the module, but others

may not. Please let us know which objects you have success with and which you do not.
• If you use CNXML-speci�c styles to create your Word document, you will get a more faithful conversion

for elements like terms, citations, code, and others.
• Even without CNXML-speci�c styling, you can make sure that your section organization is preserved

during import by using the standard Word header styles (Heading 1, Heading 2, and so on) in your
original document.



Chapter 5

Revising Your Content in Connexions1

warning: This module contains Connexions documentation which is out-of-date. The contents
of this module are provided here for historical purposes only and should not be considered

accurate for the current version of the Connexions website. Please visit the help page2 for up-
to-date information about the Connexions website, including support for viewing and authoring
content and the CNXML language. If you have any additional questions or cannot �nd the answer
to your question, please contact techsupport@cnx.org3 and we will be happy to assist in any way
we can.

5.1 Options for Revising Your Connexions Content

After you have imported a Microsoft Word �le into a Connexions module, you may discover that you need
to revise the content. You have the option to make the revisions in the original Word document and then
import it again into Connexions, or you can revise the content within Connexions using the Edit-In-Place
editor. This module explains how to revise your content using the Edit-In-Place editor.

5.2 Revising with the Edit-In-Place Editor

The Edit-In-Place editor is the default editor on the "Edit" tab. You can insert new text and media objects
into a module or modify the existing contents of a module with this editor. You do not have to be familiar
with the CMXML tags to use Edit-In-Place. It inserts the appropriate CNXML tags for you when you insert
a new item in the �le. In addition, it has a help text feature that describes the CNXML tags for the items
you insert or edit with it.

5.2.1 Editing Imported Content with Edit-In-Place

To edit the content of a module that you imported from a Word document, use the following steps:

1. Log into Connexions.
2. Display the Connexions workspace or workgroup in which your document resides.
3. Display the module you want to edit with Edit-In-Place.
4. Scroll down to display the gray text box that contains the item you want to edit.
5. Click in the text box. The gray box is replaced by a blue editing box (Figure 5.1) that displays the

text of the item.

1This content is available online at <http://cnx.org/content/m13055/1.4/>.
2http://cnx.org/help
3techsupport@cnx.org
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12 CHAPTER 5. REVISING YOUR CONTENT IN CONNEXIONS

Figure 5.1: The blue text box in the Edit-In-Place editor.

6. Make the necessary changes to the item.
7. Click Save to save the entry or click Cancel to clear the entry in the blue editing box.
8. Repeat steps 4 through 7 for any item you want to edit.

note: In the gray text boxes mathematical equations are displayed as they appear in the module.
In the blue editing box mathematical equations are displayed in the MathML markup language.
Edit equations by making changes to the MathML.

5.2.2 Adding New Content with Edit-In-Place

You can add new content items to a module with Edit-In-Place. The types of items you can add are:
paragraphs, enumerated lists, bulleted lists, equations, exercises, �gures, code blocks, notes, and examples.
Edit-In-Place places the opening and closing CNXML tags around the item and it generates a unique item
ID for each item you add. To add new items, use the following steps:

1. Log into Connexions.
2. Display the Connexions workspace or workgroup in which your document resides.
3. Display the module you want to edit with Edit-In-Place.
4. Scroll down to display the location in the module in which you want to insert the content item. You

can insert the new item above or below and existing item by using the Add Here button above or below
the existing item

5. Select the type of item you want to enter from the drop-down list next to the Add Here button. The
default is "Paragraph". These items are described in the help text, which can be accessed by selecting
"Other Elements" from the drop-down list.

6. Click Add Here. An empty blue editing box displays for the item you selected. You can display help
text for the item you selected by clicking Help editing xxx in the upper right corner of the blue box,
where xxx is the CNXML tag for the item you selected.

7. Type the text that is appropriate for the type of item in the blue editing box.
8. Click Save to save the entry or click Cancel to clear the entry in the blue editing box.
9. Repeat steps 4 through 8 for each new content item you want to add to the module.



13

5.2.3 Inserting Content in an Empty Module

To insert text and media objects into a new module that contains no content, use the following steps:

1. Log into Connexions.
2. Display the Connexions workspace or workgroup in which your document resides.
3. Display the module you want to edit with Edit-In-Place.
4. Click in the gray box (Figure 5.2) that says "Click To Insert Text" in the Edit-In-Place editor.

Figure 5.2: The "Click To Insert Text" text box in the Edit-In-Place editor.

The gray box is replaced by a blue editing box.
5. Type the text you want to add in the blue editing box (Figure 5.3) that says "Insert Module Text

Here".

Figure 5.3: The "Insert Module Text Here" editing box in the Edit-In-Place editor.

6. Click Save to save the text you typed. The blue editing box is replaced by a gray box that displays
your entry.
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Chapter 6

Publishing a Document in Connexions1

6.1 Publishing the Module

To make your module or your changes to an existing module viewable by anyone on the Internet, you must
publish the module in Connexions. To publish a module, use the following steps:

1. Log into Connexions.
2. Display the Connexions workspace or workgroup in which your document resides.
3. Display the module you want to publish.
4. Click on the "Publish" tab. The "Publish Module" (Figure 6.1) screen displays. This screen contains

a list of reminders for you to check before you publish the module.
5. Type a brief description of your work on the module in the "Description of Changes" text box.
6. Click Publish. Your work on the module is entered into the Connexions Content Commons. Once in

the Content Commons, anyone with Internet access can view the module.

1This content is available online at <http://cnx.org/content/m13054/1.2/>.
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16 CHAPTER 6. PUBLISHING A DOCUMENT IN CONNEXIONS

Figure 6.1: The "Publish" tab.

A new module would not necessarily have editing changes, so in the "Description of Changes" text box
you might enter a comment like, "Created a new module".

note: The act of publishing a module is di�erent from clicking on the Save button in an editing
session. When you save your changes, only you and the people who have access to your workgroup
can see your changes. When you publish a module, the entire world can view your work on the
Internet.



Chapter 7

Additional Connexions Information

Sources1

note: This module has been retired as it contained Connexions documentation which is no longer
accurate and/or relevant. Please visit the help page2 for up-to-date information about the Con-
nexions website, including support for viewing and authoring content and the CNXML language.
If you have any additional questions or cannot �nd the answer to your question, please contact
techsupport@cnx.org3 and we will be happy to assist in any way we can.

1This content is available online at <http://cnx.org/content/m13053/1.3/>.
2http://cnx.org/help
3techsupport@cnx.org
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New Author Guide

Instructions for creating, editing, and publishing Connexions content for Connexions authors.

About Connexions

Since 1999, Connexions has been pioneering a global system where anyone can create course materials and
make them fully accessible and easily reusable free of charge. We are a Web-based authoring, teaching and
learning environment open to anyone interested in education, including students, teachers, professors and
lifelong learners. We connect ideas and facilitate educational communities.

Connexions's modular, interactive courses are in use worldwide by universities, community colleges, K-12
schools, distance learners, and lifelong learners. Connexions materials are in many languages, including
English, Spanish, Chinese, Japanese, Italian, Vietnamese, French, Portuguese, and Thai. Connexions is part
of an exciting new information distribution system that allows for Print on Demand Books. Connexions
has partnered with innovative on-demand publisher QOOP to accelerate the delivery of printed course
materials and textbooks into classrooms worldwide at lower prices than traditional academic publishers.


